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Introduction1

This User Manual is written and intended for HFS’s Medicare Administrative Contractor
("MAC") and Fiscal Intermediary ("FI") customers, only. The topics covered in this manual
are limited to HFS cost report software tools and features designed specifically for use by
auditors and other MAC employees.  

The term “MAC”, whenever used in this manual, should be understood to include both
MACs and FIs, and the employees of both, who accept, audit, adjust and finalize cost
reports.   There is a separate User Manual for HFS provider and consultant customers
who prepare cost reports.   As a matter of convenience, we will use the term "MAC"
throughout the rest of this User Manual.  

There is almost no overlap between the features discussed in this MAC User Manual and
the features discussed in the regular provider User Manual.  

We do not provide copies of this MAC User Manual to any non-MAC HFS customers. 
HFS characterizes this MAC User Manual as confidential because it discusses various
processes for accepting, auditing, adjusting and finalizing cost reports. 

HFS requests all persons receiving a copy of this MAC User Manual, or any portion of it,
not share it with anyone who is not a member of your organization. 

The regular User Manual has several chapters that may be of interest to our MAC
customers. The sections discussing Medicare Auditor, Management Reports and
Management Reports in the 2552-10 software, Data Extractor and Batch Data Extractor,
PI Viewer, Importing ECR files and Batch Import ECR files, and the PS&R, to name just a
few.  You can download a complete copy of the current version of the provider User
Manual from our website, www.hfssoft.com in a PDF format.  The provider User Manual is
also incorporated into the cost report software.  From within any screen or worksheet in
the cost report, you can open the complete User Manual by clicking Help and HFS User
Manual - Contents.  

http://www.hfssoft.com
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The Help dialog box will appear.  Search the table of contents to locate specific topics, or
use the Windows Search feature to find key terms in the Help file.
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HCRIS Export2

MACs are required to transmit extract files (HCRIS) to CMS 60 days from receipt, or 210
days from the cost report fiscal year end date, whichever is later; or 30 days from the NPR
Date.  If this due date falls on a weekend or holiday, the HDT file is due the next business
day. All providers, except Home Office (287-05) and CMHC (2088-92) must be
"HCRIS'ed". 

HFS created an “unofficial” HCRIS for the RHC/FQHC, and this exports as an “HDA” file. 
The HDA file is not submitted to CMS, but is used by MACs for the STAR Autoload.  The
official HDT file for the 222-92 is effective for providers with fiscal year ends  on or after
March 31, 2010. Until CMS changes the STAR Autoload, MACs need to use the HDA file
for STAR, and the HDT file for HCRIS.  The CMHC (2088-92) HDT/HCRIS should be
created by CMS in the near future.

The HFS HCRIS feature creates the .HDT file from an as-filed cost report file (.mcr or
.mcrx).  The Export feature can create a single file from a single cost report file, or you can
run the HCRIS Batch and create numerous .HDT files from multiple cost reports in a batch
process. 

To run the HCRIS Export feature you must be logged into the cost report software as a
MAC.  To accomplish this, first enter your MAC number in the FI Options screen, which is
accessed through Preferences on the Options menu.  Next, you need to literally login to
the MAC only features of the software.  To login, select the Options menu and click
Login.  Enter your username and password. The login will only work if you have been
granted login rights in your organization's Grants and Profiles configuration.  If you
successfully completed both of these authentication steps, you can create .HDT files.  To
start the HCRIS Export feature, you must open the cost report you want to HCRIS.  Then
point to Export, on the File menu, and select HCRIS. This command starts the HCRIS
Export feature.  You will see the HCRIS Options dialog box.
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HFS defaults the HDT file name to “HCxxxxxx.HDT”, where the x’s represent the provider
number. HFS will customize the default name on request.  The MAC may change the
prefix of “HC” to any prefix, but the extension of ".HDT" may not be changed.  As long as
the prefix has no periods prior to the “.HDT” extension it is permissible (e.g.
FQ140634123108.HDT). The MAC designates the export destination (drive and folder). 
A HCRIS Summary Report is produced after the Export is finished. The HCRIS Summary
Report includes the Name, Number, fiscal year, date created, etc.  This can be printed to
a file (PDF), or to a printer, to document the creation of the HDT file. Verify the HDT output
location and decide it you want to print the HCRIS Report to PDF.  When you are finished
click Ok to Export the HDT file.  When the Export process is finished, the following dialog
box will be displayed.
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Review the summary information.  When finished, click Done to close the dialog box.

2.1 Batch Export

Batch Export enables MACs to export numerous HDT files as a batch process.  To run the
Batch HCRIS feature, open the File menu and select either of these two command
sequences:

Select Batch and click Export;

Select Export and click HCRIS Batch.  
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In the Batch Export dialog box, enter the folder(s) where the files you want to Export are
located.   When this option is selected the Export feature will Export HDT files from all
valid files located in the folder(s) you identified.  There is no limit to the number of files that
can be processed in Batch mode.  The other option is to identify the files you want to
Export.  When this option is selected, only the files you specifically identify will be
Exported to HDT files. After you select and configure either option, click Next to proceed.

The files you identified or the files in the folders you selected will be examined by the
software.  After the files have been checked, the Export dialog box will appear.
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On the left side of the dialog box you will see the results of the file checking performed by
HCRIS.  There is a heading for the cost report types found (item #1)(2552-96 in this
example).  Beneath that heading are the file names of the valid cost report files found. 
Under the heading Unknown Files, any damaged or invalid files are listed. (item #2)

Next, select each of the files listed under item #1.  As you select each file the Settings and
Notes tabs will appear.  
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The Settings tab allows you to choose whether to export this particular file by clicking and
selecting or clearing the Export this file check box.  The location of the .mcr or .mcrx is
displayed, as is the location of the .HDT file.  Click the Change button to change the
location of the .HDTfile.  Click the Default button to make the currently displayed file path
the default output destination for all .HDT files. Select Print HCRIS report to file to print
the report to a PDF file.  If the option is selected, the HCRIS File text box will be enabled
and you can click on the text in the box and modify the location and filename.

Click the Notes tab and enter your notes regarding the selected cost report file.  Repeat
this process for each cost report file to be exported.  Click Export to proceed.
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When the export is complete, the screen shown above will appear.  The settings tab will
display the names of the HCRIS file, the .mcr file, and the PDF report. Any HCRIS edits
will be noted on the bottom of the dialog box and must be resolved.

The Notes tab will display information regarding the export process and will indicate the
presence of Consistency Edits. Click OK to close the dialog box.
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Threshold3

The Threshold report is located on the Tools menu.  You must be Logged In as a MAC
(i.e. an MAC Number entered and security clearance), in order to access the Threshold
Report.  The Threshold is automatically calculated during ECR Import, and after each
calculation.  HFS defaults to the CMS Uniform Desk Review “threshold amounts”, and
computes the Threshold in accordance with the UDR instructions.  To modify the
Threshold amounts, click  Options, Preferences, Fiscal Intermediary, 2552-96.  The
screen displayed may be modified for any of the Threshold amounts.  Any changes will be
reflected in the next calculation.

This same screen contains the "Medicare Impact Amount" for the CAH, Special Report
#905.
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Acceptability Checklist4

You must be logged in, or have rights to use the feature, in order to run the Acceptability
Checklist feature. The software defaults to the Uniform Desk Review checklist.  A MAC,
with administrative rights, may modify (add questions to) the checklist. When in Admin
Mode, at the upper left of the checklist screen, you can add a question number (e.g. #9),
and a Description (e.g. Test Add Question).  This will then be displayed in the Part I
questions at the lower middle of the screen.  You can also add a new part (e.g. Part II).

The Acceptability Checklist automatically populates the name, address, provider number,
fiscal year, etc., during ECR Import.  HFS also automatically answers some questions
(e.g. Were there any Level I errors?).  HFS recomputes the encryption codes for the ECR
and PI files (using the CMS mandated algorithm), and prints the encryption code from the
ECR or PI file, as well as the HFS recomputed codes.  If they match, this ensures the
integrity of the files.  These encryption codes may not match the submitted Worksheet S
signature page, as this page could be from another file.  The MAC is responsible for
matching the encrypted Worksheet S, and the ECR/PI codes in the checklist.  The ECR/PI
and recomputed HFS codes are displayed in the middle of the screen – “HFS Automated
Information”.

At the bottom middle of the checklist screen, you will see the “Parts” (Review and Part I). 
You select the Part and the input for it is displayed at the upper left of the screen (Review
has the Date received, Preparer, etc.).  If Part I is selected, questions 1-8 are displayed at
the lower middle of the screen, and the answer portion for these questions are in the
upper left portion of the screen.  When you answer (or change an answer) at the upper left,
it will also display in the lower middle section.  Comments may be typed in, and will be on
the printout.

The checklist can be printed to a file (PDF) or to a printer.  You may print either the entire
checklist, or only the Review section or the Part I section.  Print “preview” is also an option,
in lieu of printing on paper.  You can add “extra lines” for comments (i.e. if the user added
comments are on the printout, but Reviewer comments need to be added later).
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Batch Acceptance5

The Batch Acceptance process was developed to work with the HFS Batch Import
process.  The Batch Acceptance Tool is the next step in automating the Cost Report
Acceptance process. At this time, that includes 2552-96, 2540-96, 1728-94, 265-94, 222-
92, 2088-92 and 1984-99.  The 287-05 does not submit an electronic cost report and is
not included in this list.  This is a MAC only feature.

The Batch Acceptance Tool is fully interactive with the cost reporting software.  This
feature takes advantage of the ability to open multiple cost reports at once.  It is interactive
with the cost report Acceptability Checklist, Threshold Report and Administrative
Features.

The Acceptability Checklist is meant to run with a list of cost reports that were run through
the Batch Import.  The Batch Acceptability Checklist is started by opening the Tools menu
and selecting Batch Acceptance.  

The Batch Acceptance feature can be started with or without an open cost report file.  The
Tools menu will look like this if no cost reports are open.  

The Tools menu looks like this if a cost report report is open in the cost report software.
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The first screen shows the Log File Options.  The log file is created when an ECR Import
is run.  You will see a Log file for individual Import functions and ECR Batch processes. 
This file holds the information about which files were imported and where.  
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Log files are stored in the MCRIF32 folder by default. This location can be changed by
entering  a valid location in File Locations. To modify File Locations, select Preferences,
SetUp, and File Locations.

The Import Log Folder location can be changed by clicking the Browse button and
choosing another location.  The screen will then show the log files in that folder.  Log files
are currently named import **************.xml.  The ***** are numbers that HFS assigns to
the file name.  In the import Logs window the system shows the date and time that the
batch Import took place.  

Once a Log file is clicked, more information about the import will be shown under Import
Log Information. You can see how many files were imported, what type of files imported,
the name of the file, the Accepted Status and the Reviewed Status.

Below the Import Logs window you have two options. If you click “Only Show Logs with
Unaccepted Reports”,  only Log files with one or more unaccepted reports will be shown
in the window.

The  “Automatically Accept or Reject when viewing”  option lets the system make the
accept or reject determination based on data retrieved from the Acceptability Checklist.  If
all Acceptability Checklist questions are marked "Yes" or "N/A", the report will be marked
"Accepted".  If there are any "No" answers on the Acceptability Checklist the report will be
marked "Rejected" until the answer is changed.  With this option checked the Accept
check box on the next screen will be disabled.  If this option is not selected, you will be
able to change the Accepted status manually.  To see the list of files imported and their
current status, select a log file and click the View button.
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This screen is a spreadsheet .  The Cut, Copy and Paste commands are enabled. The
boxes and grey areas at the top of the screen will globally answer all lines in that column. 
With the Batch Acceptability Checklist open you can open cost reports (just by clicking the
provider number or FYE) and look at forms including the Acceptability Checklist.  The
screen shot shown above is the first half of the columns shown in the Batch Acceptance
screen.  The picture of all columns was too wide to fit within these page margins.  The
following are descriptions of each of the columns displayed on this screen. 

Type – The Type column displays the form set or type of provider cost report. 

MAC – If you are processing reports for a single MAC area you will have your MAC
number entered under Preferences.  This column will show that number.  If you are
processing reports in multiple MAC/FI areas you should use our MAC# Look up feature in
our Admin Preferences area.  This column will display the MAC number that was looked
up.  

Accepted – This column is an automated field if on the previous screen the “Automatically
Accept or Reject when viewing” option is checked.  If you want to manually change this
column push Done and go back to the previous screen and uncheck that option. If the cost
report is Accepted, it will be marked with a black check mark and be highlighted in yellow.
 If it is Rejected it will have a grey check mark and be highlighted in orange. Acceptability
Checklist Questions 1 – 8 must be Yes or N/A for a cost report to be considered
Accepted.  This is updated real time.  If an answer is changed either on the Acceptability
Checklist or on the Batch Acceptance screen the Accepted answer is updated if the
automated option is checked. The Date Accepted will be filled with the date that this
provider became Accepted.

Provider Number – Displays the provider number from the cost report data file (.mcr).

FYE – Displays the Fiscal Year End from the cost report data file(.mcr).
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OCR Signed – This column corresponds to Acceptability Checklist question 4. “Does the
Certification Page (Worksheet S) of the ECR file include an original signature signed in
ink by an officer of the provider?”  This box is manually checked after checking the
submitted, encrypted Worksheet S.  A single click will input a black check mark indicating
a Yes answer.  Another click will turn the check mark grey indicating a No answer.

339 Signed – This column corresponds to Acceptability Checklist question 8. “Has a
Form CMS-339 been completed and submitted with an original signature signed in ink by
an officer of the provider?” This box is manually checked after checking the to see if the
Form 339 was submitted.  A single click will input a black check mark indicating a "Yes"
answer.  Another click will turn the check mark grey indicating a No answer.

ECR Encr. Match - This column corresponds to Acceptability Checklist question 5a. 
“Does the encryption code, date and time for the ECR displayed on the certification page
match exactly that of the ECR file encryption code, date and time?  The matching of the
date and time is between what is printed on the signed certification page and the date
and time within the ECR file.”  The system shows the information it collected from the EC
file on the ECR Encryption tab.   If the user tabs through the fields, this tab will
automatically be opened when resting on this column.   A single click will input a black
check mark indicating a Yes answer.  Another click will turn the check mark grey indicating
a No answer.

PI Encr. Match - This column corresponds to Acceptability Checklist question 5b.  “Does
the encryption code, date and time for the Print Image displayed on the certification page
match exactly that of the Print Image file encryption code, date and time?  The matching of
the date and time is between what is printed on the signed certification page and the date
and time within the PI file, worksheet S.”  The system shows the information it collected
from the PI file on the PI Encryption tab.   If the user tabs through the fields, this tab will
automatically be opened when resting on this column.   A single click will input a black
check mark indicating a Yes answer.  Another click will turn the check mark grey indicating
a No answer.
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The answers to these questions are real time interactive with the Acceptability Checklist. 
When the user answers a question on this list, they can then view the Acceptability
Checklist and see that answer.  The vice versa is true; if a user answers a question on the
Acceptability Checklist, the answer will immediately be reflected on the Batch Acceptance
list.

IRIS – This box is manually checked after checking the to see if an IRIS diskette was
needed, was an IRIS diskette submitted and did it pass the IRIS edits.  A single click will
input a black check mark indicating a Yes answer.  Another click will turn the check mark
grey indicating a No answer.

Receipt Date – This date is set during the Import process.  The default is to pick up the
date of the import but users can set the date during the import.  This field will fill the
Acceptability Checklist Receipt date.  This field can be globally changed by entering the
date in the grey area of the column heading.  This field is also used for the FI/MAC Wkst S
screen used for HCRISing.
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Note: this picture shows the other half of the columns in the Batch Acceptability Checklist.

Postmark Date - This field will fill the Acceptability Checklist Postmark date field.  You
can change the date on the screen with copy and paste or just entering.  If you enter the
date in the grey area below the heading,  that date will be copied to each line.

Acceptance Date – This field will fill the Acceptability Checklist Acceptance date field. 
You can change the date on the screen with copy and paste or just entering.  If you enter
the date in the grey area below the heading your entry will be copied to each line.  This
field is also used for the FI/MAC Wkst S screen used for HCRISing.

NPR Date - This field will fill the FI/MAC Wkst S screen used for HCRISing.  You can
change the date on the screen with copy and paste or just entering.  If you enter the date in
the grey area below the heading your entry will be copied to each line.   

MCR Type – This is a drop down box so you can select the HCRIS type.  The default is a
1 – As Submitted.  The only exception to this is if you have a file that qualifies for Straight
to Settlement and then, when a client HCRIS’s through the Batch Acceptance the file is
first HCRIS’d as a 1 - As Submitted and then again as a 2 – Settled w/o Audit. ( HCRIS
feature coming soon.)

Reviewed – If checked the Reviewed Area will show as Accepted.  The date this was
checked will show in the Reviewed section.  If the Reviewer clicks on the box above the
cost report lines and below the header all files will be checked as Reviewed. The
Reviewer  Name field on the Acceptability Checklist is automatically filled in if the user has
logged in and their name has been entered in to the Administration Feature screen. 
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Straight to Settlement – This box is only applicable for 2540-96, 1728-94 and 2088-92
reports.  The box will be checked if the Threshold Report shows that this report qualifies
for Straight to Settlement.  The user can uncheck the box, but if the report is calculated
again the check mark will be entered again. 

Tentative Exempt - This box is only applicable for 2540-96, 1728-94 and 2088-92
reports.  The box will be checked if the Threshold Report shows that this report qualifies
for Straight to Settlement.  The user can uncheck the box, but if the report is calculated
again the check mark will be entered again. 

HCRIS Consistency Edits – If the file has Consistency edits this column will show how
many.  We’ve also added a tab so you can see what the HCRIS edits are.

The Status tab will show questions not listed above that have a "No" response on the
Acceptability Checklist so you will see why the file has not received "Accepted" status. 
The Status tab also shows other helpful information: Prepared Status, Prepared By,
Prepared Date and the location and name of the data file.
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5.1 Printing Reports

With a file selected, you may Print or Print Preview the Acceptability Checklist using the 
Print Form and Preview Form buttons on the Tool Bar. Click the File menu and select
Print.  The Print Options dialog box will be displayed.

By default all files are selected for Print.  You can uncheck the box next to the Provider
number and name to not print anything for a particular provider.  The system also assumes
that you would like to print the Acceptability Checklist for all providers listed.  Again, this is
the default but by removing the check mark to the left of the Acceptability Checklist option
the report will be de-selected and not printed.

You will be able to customize what will print for each provider listed, by clicking on the
provider and then choosing which reports you want in the Available Reports window
below.  Currently we have the following under Available Reports: Acceptability Checklist,
Entire Cost Report, Edits and Threshold.  The Available Forms tab will show you all of the
forms for that provider type, again you can select whatever you want to print for each
provider listed.
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Chances are you probably print the same thing for each provider type.  If this is the case,
then set up your preferences for what the defaults should be for each provider type by
clicking on the Preference button.   The following window will allow you to set up exactly
what reports should be printed by provider type.   You see that these defaults will be just
for reports that have been marked Accepted.

If, for all 2540-96 reports, you are required to print the Acceptability Checklist, the Entire
Cost Report and the Threshold, select those reports.  Remember that all reports can be
printed to PDF and we can use any special naming convention if you tell us what you
need.

Also note that all of our Special Reports are available with the regular forms on the 
Available Forms tab.  So, if for Hospitals, you always want to print Special Report 916 –
OPPS RCC Report, you would select it from the Available Forms tab.    
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If you are printing to a network printer, all print jobs will be held in a queue until the printing
is complete.  This should ensure that all of your print jobs are sent to the printer as one job
and will not be interrupted by other print jobs. At the bottom of the Print screen you can
also choose to Print the Session Report.  If you select a folder where the files are to be
stored all PDFs of the reports you have selected will go to that folder. When you click the 
Print button a window will show the status of what is being printed. All reports can be
calculated by clicking the Calculate All button.  



Batch Acceptance 23

Copyright 2008-2013 by Charles H. Briggs, Jr.

It may be useful to calculate all the files if, for instance, you changed or added a receipt
date.  That modification may clear Consistency edits and allow the files to be HCRIS'ed
after the files are calculated. Next to the Calculate All button you will find the HCRIS
button.

When finished, click the HCRIS button and you will see the following screen.
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Select from the list of options either: Show All Reports, Accepted or Straight to
Settlement.  If you select Hide HCRIS’ed files, you will only see files that have not yet
been HCRIS’ed.  The check box next to each report needs to be checked for the file to be
HCRIS'ed.  The system will show files in blue if it finds that the HCRIS already exists in the
target folder.  The system will highlight the filename in red if the file has Consistency edits
and cannot be HCRIS’ed.  The system will create the standard HCRIS reports and these
can be printed to a PDF.  The Output folder is where the HCRIS files will be prepared. 
When finished selecting options and confirming the configuration, click the HCRIS button
and the all of the selected files will be HCRIS'ed.
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MAC Login & Access System6

The MAC Login and Access System is a comprehensive and secure administrative
feature that is only accessible to MAC users and also allows MAC administrators to grant
or limit  administrative rights and privileges of their employees. MACs enjoy unrestricted
access to all the special MAC features built into the HFS cost report software.  These
special features include, but are not limited to, the Acceptability Checklist, Batch
Acceptance, Threshold, HCRIS Export and Batch HCRIS Export, NPR, PDR, and the
Wage Index Checklist.  Access to certain high-level administrative tasks may be restricted
to certain employees. It is up to each organization to decide whether, and to what degree,
administrative rights and privileges will be assigned to various users. Within each
organization there should be one person designated as the administrator of the security
system for the cost report software.

Note: The special features mentioned above are not available to HFS provider clients. 
These features are not accessible unless the user is logged into the software as a MAC.

The security feature can be pre-configured for use in your organization.  The designated
administrator in your organization should contact HFS technical support to discuss the
particulars involved in configuring the security feature for use in your organization.  The
administrator will need to provide HFS with detailed information that will enable HFS to
configure the administrator’s rights and privileges.

The administrator may be asked to furnish the following information to the HFS technical
support staff:

full name;

FI number;

user name and password used for downloads from HFS website;

e-mail address; 

title; and

feature/task levels they need access to (i.e. review, supervisor, administrative access,
etc.).

HFS will provide files to the administrator that will allow the administrator to set up the
organization’s members with appropriate permissions.  Once the administrator adds
these pre-configured files to the organization’s cost report software folder, the
administrator will be able to login to the software as the administrator.  To login as the
administrator, select Login from the Options menu.
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Enter the administrator's user name and password and click Ok.

Once you have logged into the system, the Login command on the Options menu will
change to Logout.
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After you login, you can access the Administrative Tasks portion of the software.  Open
the Tools menu and select Administrative Tasks.

 

The Administrative Tasks screen will appear.
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In the above example no employees have been added/configured. The Administrator will
be able to assign himself/herself full administrative rights. In addition, the administrator
can assign different levels of rights to other employees. Employees should be assigned to
various groups, such as “Auditors” or “Reviewers.” Usage rights can then be assigned to
groups. All members of a particular group will be vested with the rights assigned to the
group in which they are a member.
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tasks. The administrator will usually need to create additional Administrators.  Click  
Administrators and then the New User button and the User Information section of the
current window opens.

Enter all the required information and then click the Add button.  
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In the screen example above, user “Sue Smith” has been added to the Administrator’s
group.  In the example below, the user account may be edited or deleted by checking the
box to the left of the user’s name, and then clicking on the appropriate toolbar button.
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"Auditors,Techs" can be added in the same way.  Select the “Auditor, Tech” group and
then add this group’s members in exactly the same way.
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Notice that this group has fewer rights than the Administrators group.  Remember that
certain tasks are automatically assigned to certain groups.  Additional permissions may
be assigned to the group by simply checking the appropriate check boxes.

A new group can be added by simply clicking on the “New” icon in the “Groups” section of
the feature.
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Enter the name of the new group and it will be added to the list.  In addition, by selecting
an existing group and clicking the Rename button, you can rename it.  One of the pre-
defined groups is named “No Login Required.”  This group will not contain any users.  Any
features and tasks assigned to this group will be available for all users and will not require
users to login before they can use the features and tasks assigned to that group. Below is
an example of the “No Login Required” group:
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After making changes in the Feature Administration section, use the “NetSync” feature to
publish the new settings to the network drive.  To access the NetSync feature, click the
Windows Start button and point to All Programs, Health Financial Systems, Tools
and select HFS Admin Suite.  Enter a note you want, and specify the shared folder you
where you will publish the updates.   Click the Publish to Network button.  As individual
users synchronize their software with the network, the Feature Administration options will
be incorporated into their cost report software.  
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Special Reports7

All of the HFS Special Reports (currently there are thirteen Special Reports) have been
converted to worksheets.  Like other worksheets, you can copy and paste, to or from
these worksheets, as well as print them to a file (just like any other worksheet). You can
also Batch Print any of the Special Reports (from the File menu point to Batch and select
Print Batch.   These reports are also accessible from the Print command on the File
menu. (If there is no input required, the report is calculated along with the rest of the cost
report, and can then be printed). Reports #910 and #920 require user input. Open the
reports by selecting Open from the File menu and select the Reports from the list of all
worksheets. Enter data in the Reports and then calculate the cost report.

The following is a detailed list and summary of the thirteen HFS Special Reports.

1. Interns Residents (Bed/Census) Report, or SR #902 (see CMS Pub. 100-
04, Section 20.2.3) – This is used to compute the Intern to bed ratio for IME
payments and Capital IME (part of FISS).  This is run for audit/settlement
purposes.  It may also be used for interim payment calculations.  It is SR #902
in the list of worksheets displayed in the Print Form dialog box, and can be
printed.  To print the report from the Print Form dialog box, select SR #902, at
the bottom of the worksheet list and click Print. You can also print to a file
(PDF).

2. Long Term Care (RCC) Report SR #903 – P.M. A-02-093 and Change
Request #5202.  This can be used to compute Long Term Care hospital’s PPS
payments, and Outliers. This can be run at Tentative and Final Settlement for
interim payment purposes (FISS).  The I&R to Beds Ratio Report, the I&R to
Average Daily Census Ratio Report, and Medicaid Ratio, were incorporated in
this report in 2/2007 to consolidate all info on one Report, and to incorporate
changes made to the short stay outlier computation initiated in Pricer on
7/1/2006, per Change Request #5202.  This includes the Bed Size and
Average Length of Stay calculation (ALOS), for this report. It is SR #903 in the
list of worksheets displayed in the Print Form dialog box, and can be printed by
selecting SR #903 from the bottom of the list and clicking Print.  You can also
print to a file (PDF).

3. CAH Medicare Impact Report or SR #905 - this report calculates the
Medicare utilization (days to days), and applies this utilization factor to
adjustments, to estimate Medicare Impact.  It is SR #905 in the FILE, Print
menu, (File, Print, SR #905 at the bottom of the list).  You can also print to a file
(PDF).  

4. Florida Medicaid Settlement Summary, SR #908 - this report has the
special attestation for Florida Hospitals, on the W/S S settlement summary
page.  It is SR #908 in the FILE, Print menu, (File, Print, SR #908 at the bottom
of the list).  You can also print to a file (PDF).  
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5. CAH Per Diem with Bad Debt, SR #909 - this similar to the SR #910, but
includes Bad Debt cost in the per diem calculation.  It is SR #909 in the FILE,
Print menu, (File, Print,SR #909 at the bottom of the list).  You can also print to
a file (PDF).  

6. CAH Per Diem Report, or SR #910 - this report calculates the per diem for
Hospital, both Part A and Part B, as well as SW/Bed Part A and B.  It is SR
#910 in the FILE, Print menu, (File, Print, SR #910 at the bottom of the list). 
You can also print to a file (PDF).  

7. Psych Rate Report SR #911 – Change Request #3541.  After the cost report
is calculated, click on Forms, Print, SR #911 (at the bottom of the list), and you
can Print or Preview the report.  This is the cost to charge ratio report for Psych
Hospitals or Subproviders, effective for FY Begin 1/1/2005 and after.  This
provides the RCC for the interim rate setting.  The I&R to Average Daily Census
Report was incorporated in this report to make all Psych info available in one
report, per Change request #3541. Use the Print Preview Icon to view/print the
Report.  You can also print to a file (PDF).

8. CAH 96 Hour Verification Report, or SR #913 - Used to verify the 96 hour
maximum stay for inpatients.  We use the actual hours on Worksheet S-3 part I,
column 4, but if these hours are “1” just to pass the edits, we also compute an
estimated length of stay by dividing days by discharges, and multiplying by 24
hours.  Use the Print Preview Icon to view/print the Report.  You can also print to
a file (PDF).

9. OPPS RCC Report (Excluding Paramed Ed and Allied Health cost), or
SR #916 - Change Request #5238 and P.M. A-03-004, is used to compute
interim TOPs Payments and Outpatient PPS outliers.  This is run for settlement
and interim payment purposes.  This Report replaced the OPPS RCC Report in
2/2007, as it is the same Report if there are no Paramed Ed costs.   It can be
printed (File, Print, SR #916, at the bottom of the list).    You can also print to a
file (PDF).

10. Cost to Charge (RCC) Report, or SR #917 – Change Request #3966.  This
is used to compute the acute care PPS Operating and Capital cost to charge
ratios, for Outliers; and DSH adjustment.  This is run at Tentative, and to Settle
reports, but may also be used to set interim payments, i.e. used to calculate the
Medicaid ratio for FISS, to pay DSH during the year.  You can Print (File, Print,
SR #917, at the bottom of the list) the report, or Preview it.  You can also print to
a file (PDF).

11. Pass Through Per Diem Report, or SR #918 – this report computes the
Allied Health and Med Ed pass through costs, on a per diem basis.  It is SR
#918 in the 32-bit system, and can be printed (File, Print, SR #918, at the
bottom of the list).  You can also print to a file (PDF).
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12. Rehab Rate Report (formally Special IRF Report), and now SR #920 –
P.M. A-01-131 and Change Request #1921, #2978 (also see Pub.100-04,
section 140.2.6). You can Preview or Print the SR #920.  We compute the
Medicaid ratio for LIP payment purposes.  FIs use this report to update the
provider payment history.  This can be run each time the report is
‘processed” (Tentative, Final, Reopening). The I&R to Average Daily Census
Report was incorporated in this report to make all Rehab info available in one
report, and is per Change Request #4037.  The Medicaid ratio was added to
this report per Change Request #1851.  Use the Print Preview Icon to view/print
the Report.  You can also print to a file (PDF).  We compute the Under/Over the
Threshold amounts, and then transfer this Under/Over to the Acceptability
Checklist.

13. HITECH FISS Data Report, or SR #921 - this report displays the days,
discharges, charges, and charity care, and cost of EHR equipment, for both
CAH and Non CAH hospitals. This data is to entered in FISS within 5 days of
acceptance.
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Wage Index Verify8

The Wage Index Verification tool was created to help MACs verify submitted HCRIS data
against the actual cost report files used to submit that HCRIS data. The Wage Index
Verification feature is started by clicking Wage Index Verification on the Tools menu.
Specify the folder with the CMS Public Use File (“PUF” ) that you have saved as a “.csv”
file. Then specify the folder where the cost  report files are located.

8.1 Using the Wage Index Verify

The Wage Index Verification feature will examine the HCRIS data you received from CMS
in th PUF file and compare that data to the actual cost report files.  To do this, follow these
simple steps.

1. Open the CMS HCRIS.xls(PUF) file in Microsoft Excel.

2. From the Excel File menu, choose Save As.

3. From the Save As dialog, select the folder where you want to save the HCRIS data.
Next, in the Save as type list box, choose “comma delimited".  Finally, click the
Save button.  (If you want to improve efficiency, save only those files/records specific
to your MAC number.)

4. Close Excel.

5. Decide which folder will contain all of your cost report files and copy those files to
that folder. Note: Its okay for the folder to contain sub-folders with   cost report files. 
Also, the cost report files can be either .mcr, .mcrx, .mca or .mcax files.

6. Start the Wage Index Verification by clicking Wage Index Verification on the Tools
menu. You will see the following screen:
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7. In the HCRIS File box, type the name of the HCRIS data file you created in step #3
above. You may also press the Browse button to browse for the  HCRIS file (PUF).

8. In the Cost Report Folder box, type the name of the folder where your cost report
files are located. This should be the same folder you decided      upon in step #5
above. You may also press the Browse button  to browse for the desired folder.

9. If you created sub-folders and those folders contain cost report files you want to
search, place a check mark in the box labeled Include sub-folders  in cost report
file search.

10. If your HCRIS data file has data from other FIs in addition to your own and you do not
want to process the other FI’s data, enter your FI number in      the FI Number box and
make sure you DO NOT check the box marked “Do not check FI number during
processing.” If this is only for your FI/MAC    number, check the box “Do not check FI
number during processing.” 

11. When you have finished with the above steps,click the Run button.

12. When the Wage Index Verification software is ready to print the results of the
verification process. The following screen will appear:
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13. If the printer indicated is not the correct printer, press the Setup button to select the
correct printer. Press the Preview button to preview the results    of the Wage Index
Verification process.

14. On the preview screen, you can move through each page by pressing the Next/Prev
buttons.  When you are ready to print, press the Print button.

15. To close the Wage Index Verification software, press the Cancel button on the Wage
Index Verification software’s main screen.

8.2 Wage Index Verification Report

The headings on the Wage Index Verification Report contain the software version, date
and time prepared, the section title and the fiscal year begin date range for the data being
verified. This date range is determined from the HCRIS data you provided to the software.
At the foot of each page is the HCRIS data file used and the page number.  There are four
different sections on the report:

HCRIS DIFFERENCES FOUND

This section contains all of the differences found between the HCRIS data (PUF) and the
actual cost report file.  Ordered by provider number, this section shows the provider name,
number, fiscal year, and any differences found.  These differences are ordered by
worksheet and line number on that worksheet.  If no differences are found for any provider,
the message NO DIFFERENCES FOUND will be printed in this section.

SUMMARY OF COST REPORT FILES USED FOR COMPARISONS
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This section shows the cost report files that were used for the data comparisons.  Ordered
by provider number, this section shows the provider name and number, and the cost
report file used to compare against the HCRIS data.  This section will help you locate the
correct cost report file when you are researching any differences the system may have
found.  If, for some reason, no cost report files could be matched to your HCRIS data, the
message NONE FOUND will be printed in this section.

COST REPORT FILE PROCESSING ERROR

This section shows the cost report files that were matched to a provider in the HCRIS data
but could not be properly processed when the system tried to verify that HCRIS data.
Ordered by provider number, this section shows the provider name and number, and the
cost report file that caused the processing error.  This section will help you determine if all
of the HCRIS data was properly processed.  If any files show up in this section, reboot
your computer and run the Wage Index Verification software again.  If you continue to have
files show up in this section, call us so we can determine the problem.  Ideally, nothing will
show up in this section and you will see the message NONE FOUND.

DATA WITHOUT A MATCHING COST REPORT FILE

This section contains all of the HCRIS data that could not be matched to a cost report file.
 Ordered by provider number, this section shows the provider name, number and fiscal
year.  If all of the HCRIS data were matched to cost report files, the message NONE
FOUND will be printed in this section.  This section will help you determine which cost
report files you need to move into the folder that contains the cost report files you want
used for the HCRIS wage index verification.
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Notice of Program Reimbursement9

The Notice of Program Reimbursement (NPR) shows the settlement differences between
the original cost report and the adjusted cost report.  Before running the NPR, make sure
the adjusted cost report is available. A new adjusted cost report can be created by
applying all adjustments in the Medicare Auditor feature. If you change the original cost
report make sure to calculate it before working with the NPR. If you calculate the cost
report or a new adjusted cost report is created and if the NPR feature is open, all data will
be reloaded to reflect the latest changes.

 

To open the NPR feature, select Notice of Program Reimbursement from the Tools
menu.  The following screen will appear:
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Select any of the worksheets listed in the Reports section to show differences between
the as-filed and the audited cost report for pertinent line items.

Below is an example of the NPR view for Worksheet E, Part B, Title XVIII, for the hospital
component:
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Note the first column shows the As Filed amounts, the second column shows the Audited
amount and the third column the Adjusted amount (the difference).

At the conclusion of the Auditing process, the MAC issues an NPR report. A major part of
the NPR is the printing of settlement worksheets showing the amounts as submitted and
after the application of the final audit adjustments. 

As previously mentioned, these settlement differences can be viewed by clicking
Settlement Summary in the NPR Reports section.
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Due to the delays in releasing correct forms and instructions some providers filed on cost
report forms that were inappropriate for their fiscal period. When the reports were
received, the MAC needed to update the cost report to reflect the retroactive changes.
The problem was that the new instructions precluded amounts in fields that the provider
had put amounts. Some FIs were concerned that the as submitted column on the NPR
could not match the as submitted report filed by the provider. Our NPR allows the auditor
to enter amounts directly on the NPR settlement page. The system automatically
recalculates all subtotals and totals in accordance with the CMS instructions. We also
recompute the Adjustment column.

To print the NPR reports, make sure the NPR feature is active and then select Print from
the File menu. The following dialog box will appear:

Note that you can select exactly which reports to print.  In addition, by checking the Print
to File checkbox, you have the ability to create a PDF file and to choose where to save
the file.
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HCRIS File Manager - WINHTF10

The HCRIS File Manager window is the main window you will work with to create your
HCRIS Transfer Files (HTFs).  This window is divided into two sections.  The left-hand
section of the window contains a list of all HTF data you have collected.  This section is
called the HTF Tree.  The right-hand section shows the detail of what is contained in each
item of the HTF Tree.  This section is called the HTF List.

10.1 HTF Tree

In the HTF Tree you will find three different types of items.  These items are described
below.  A single click with the mouse using the left mouse button selects the item.  When
an item is selected, the HTF List provides some detail of its contents.  A double click with
the mouse using the left mouse button expands the item so you can see other items
associated with the selected item.

10.1.1 Monthly

This item represents each month of the year.  As a new month is entered, this item is
created automatically.  All other items in the HTF Tree are separated into their respective
months.  Data for each month are stored in separate files.

10.1.2 Daily

This item represents each day of the month.  As a new day is entered, this item is created
automatically.  You will process HTF data by selecting the desired day.

10.1.3 HTF Data

This item represents each of the CMS Transfer files you create on a specific day.  Up to
nine HTF items may be created for each day by appending HCRIS files.  When you
append HCRIS files to your HTF data, these items are created automatically.  Depending
on the amount of HCRIS data being appended, when the maximum capacity of the HTF
Data item has been reached, new HTF Data items will be created automatically to
accommodate the appended HCRIS data.

10.2 HTF  List

The HTF List displays attributes of each of the HTF Tree items when the HTF Tree item is
selected.  A double click on an item in the HTF List will expand that item on the HTF Tree.
 The only exception to this is when the HTF List item is a HCRIS File Data item.  A double
click on a HCRIS File Data item will display the actual HCRIS data in that file. The
following are attributes displayed for each of the described HTF Tree items selected:

Monthly –
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Day of Month – Day of the month in the format Day – Day of Week

Started by User - The HDC User ID for the user who was using the software when
the day was started.

Started – The actual date and time this day was started.

Last Accessed – When the information for this day was last accessed (i.e., when
HCRIS files were last appended or an HTF was created). 

Daily – 

Transfer File – Name of the CMS Transfer File Data item in the format of Day.File
Number – Detail.  (Note:  This is not the name of the actual HTF that will be
produced when the HTF data is finalized.  This is only the name of the HTF Data
item on the HTF Tree.)

Extracts – The number of HCRIS files appended to the HTF Data item.

Records – The number of actual HCRIS records in the HTF Data item.  (Note: This
count does not include the additional HDC control records.)

Finalized – The date and time the HTF Data item was finalized.  When you finalize
a HTF Data item, the actual HTF is created for you to transfer to the HDC.

HTF Data – 

HCRIS File – The name of the HCRIS file appended to the HTF Data item.  This
name does not include the path information of the file.

Provider – The six-digit provider number found in the type one record of the
HCRIS file.

FYB Date – The fiscal year begin date found in the type one record of the HCRIS
file.  (Note: The type one record usually contains dates in Julian format.  To make it
easier for you to know the exact date, the Gregorian date is displayed instead.)

FYE Date – The fiscal year end date found in the type one record of the HCRIS file.
 (See date note above.)

NPR Date – The NPR date is displayed, if applicable.

MCR Type – The type of MCR file: 1 Hospital; 2 SNF; 3 HHA; 4 ESRD; 5
Hospice; 6 RHC/FQHC

Date Created – The creation date found in the type one record of the HCRIS file. 
(See date note above.)

Date Appended – The date this HCRIS file was appended to the HTF Data item.
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10.3 HTF User Identification

The “HTF” file is e-mailed to CMS/HCRIS. When the WinHTF HCRIS Transfer File
Manager software starts, you will be asked to enter your assigned HDC ID.  Enter this
information in the space provided and press the OK button. Your user ID will be stored for
the next time you start the software so you do not have to enter it each time.  You will,
however, be prompted for it when the software starts. Press F2 or choose Change
User… from the Actions menu to change the user ID while in the software. 

10.4 MAC Information

The CMS Transfer File (HTF) is required to have the MAC Number and MAC Location
Code in the first record of the file.  If you have not already specified your MAC Number
and Location Code, you will be prompted to do so before you can finalize any HCRIS data
to a HTF. Your MAC information will be stored so you do not have to enter it each time you
use the software. Choose Edit Fiscal Intermediary Information from the Actions menu
to change your MAC information while in the software.

10.5 Appending HCRIS Files

In order for you to create your CMS Transfer File (HTFs) for CMS, you must append
HCRIS files to an HTF Data item on the HTF Tree.  You can have up to nine HTFs each
day.  The WinHTF software will ensure that your HTFs contain the maximum amount of
data allowed by the HDC in each transfer file. To append HCRIS data, first select the day
that will hold the data.  Next, press CTRL+A or select Append HCRIS Files… from the
Actions menu.

Next you are given two options:

Append HCRIS files located in this directory – With this option you specify a directory
that contains HCRIS files you want to append.  All HCRIS files with an extension of .HDT
will be appended.

Append only these HCRIS files – With this option you specify the exact files you want to
append.  You can specify specific files in one or more directories on one or more drives.

NOTE: If the HTF Data item has already been finalized for that day you will not be able to
append additional HCRIS data to it. If the maximum capacity of the HTF Data item has
been reached, a new HTF Data item will be automatically created to continue collecting
the appended HCRIS files. If the maximum number of HTF Data items has been created
for that day, you will not be able to append any more HCRIS files to that day’s HTF Data
items. After all selected HCRIS files have been either appended or skipped because of
an error condition, you can select an HTF Data item to view the HCRIS files that were
appended.  If there were any files rejected during the append process, a list of those
rejected files will displayed.
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10.6 Creating the CMS Transfer File

In order for you to create your CMS Transfer File (HTFs) for CMS, you must finalize the
HTF Data item on the HTF Tree.  You can have up to nine HTFs each day.  The WinHTF
software will ensure that your HTFs contain the maximum amount of data allowed by the
HDC in each transfer file.

You can finalize one or all HTF Data items for the selected day.  To finalize a single HTF
Data item, select the data item using the mouse and then follow the instructions below.  To
finalize all of the HTF Data items for a day, select the Daily item using the mouse and then
follow the instructions below.

Note:  Once you finalize an HTF Data item you cannot append more HCRIS files to it. 
Before you finalize be sure you have finished appending files.

10.7 Finalizing

Press CTRL+F or  select Finalize HCRIS Files… from the Actions menu. If you have
selected a Daily item (i.e., you want to finalize all HTF Data items), you will be prompted to
confirm that you want to finalize all HTF Data items for that day that are not already
finalized.  Press Yes to finalize or No to abort. If an HTF Data item has already been
finalized you will be asked if you want to finalize it again.  Press Yes to finalize or No to
skip this HTF Data item.

The standard HTF file name for you to transfer is P@HCR.#2222.FI00000.HTRAN. Note:
the zeroes after the “MAC” will instead be the actual MAC number that is normally used by
the submitting organization.

To distinguish between multiple extract files, the WinHTF software adds two extensions to
the file name. The first extension indicates the date HCRIS information was collected for
this finalized HTF extract.  The second extension indicates the sequence number for the
data HCRIS collection on that collection day (1 for first file of day, 2 for second, etc.). The
following is an example of the HTF file created by this software and then transferred to the
HDC: P@HCR.#2222.FI12345.HTRAN.20001001.01 (Created 10/01/2000 as first file of
day).

mailto:P@HCR.#2222.FI00000.HTRAN
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The PDR is located on the Tools menu.  This is the CMS PDR to be used for all desk
reviews beginning January 1, 2008 and after. HFS programmed both the Full and Limited
scope desk reviews.  You select one at the upper left portion of the screen.

The CMS questions/sections are on the left side of the screen.  On the right side of the
screen, we have three “windows”.  The top window is the actual CMS verbiage for the
question highlighted on the left.  The middle window is for your remarks/comments – you
can type in your comments, and they will be printed on the output.  The bottom window is
for any HFS information (i.e. data from the cost report).  As you move through the
questions on the left side of the screen, the right side will change accordingly.

You can enter a work paper reference, preparer name, date prepared, etc.  All of the CMS
paper copy PDR is automated.
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Wage Index Checklist12

To open the Wage Index Checklist, you must be logged into the cost report software and have FI/

MAC security access.

You should open the current year cost report file and then choose Wage Index Checklist from the

Tools menu.

If a Prior Year file has not been selected, click the Browse button on the Prior Year file line to select

a prior year file.  You can select either a .mcr or .mca (adjusted cost report) file.

The system detects if the Current Year and Prior Year file have been calculated. If not, the system

will prompt you to calculate the file.

If you would like the system to use the current year adjusted cost report click the option in the

upper left corner of the screen.

Once the checklist is open, you will see the CMS Questions on the left side of the screen.  On the

right side of the screen, the detail information for the question that is currently highlighted will be

displayed.   
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The initial screen displays the Introduction to the Wage Index Checklist.  If your system is set up for

logins, the Auditor’s name will be automatically entered in the Auditor field.  If the user is signed in

and has been set up with Reviewer Rights, their name will appear as the Reviewer.  Dates can be

entered by typing them in the date box.  The Reviewed Date will populate if the Reviewer is signed

in and checks the “I have reviewed the Wage Index Checklist”.  If a user is logged in and does not

have Reviewer rights, the Reviewer information will be greyed out.

To browse through the questions in the right hand task pane, you can use your mouse to click on the

questions or the CTRL+N and CTRL+R keys to go to the next and prior questions.

When a question is selected you will see Pass and Review boxes at the top of the screen.  If we have

enough information to answer a question we will automatically select Pass or Review.  You can

override our answer at any time.  If Review is checked, the question name in the left hand task pane

will be bold.

Below the Pass and Review boxes you will see three sections: Instructions, Comments and HFS

Automated Information.  The Instructions are from the CMS Wage Index Checklist; the Comments

box is enterable and is where you will enter information.  This information will be printed exactly as

you input it on the printed copy or in the PDF version.   The HFS Automated Information is the data

that we have gathered form the cost report that is applicable to the highlighted question. 

To Print the Wage Index Checklist, click the Print Form icon or go to Forms | Print Form.  
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From this screen you can choose which sections you want to print and choose the applicable cost

report forms (CY and PY) to print.  The buttons at the bottom of the screen allow you to Select All

parts to print or you can Clear All of your selections.  If you click the Print Extra Lines for written

notes, blank lines will be added to the questions so you can handwrite on the printed document. 

When you choose Print to File the system will default to creating a PDF file named with your cost

report file name followed by the text “WageIndexChecklist.pdf”.

While in the Wage Index Checklist, if you go back to Tools | Wage Index Checklist, you can choose to

Clear Comments, Calculate the Wage Index Checklist or Update the template.

If you have Administrative Rights, then you may add questions to the checklist.  The standard CMS

questions may not be modified or deleted, but you can add new questions and distribute a

template to your users.  For more information, please contact HFS.
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We added a new feature to allow a MAC with multiple jurisdictions, to import all the
provider numbers and FYE dates from STAR (must be in an Excel format of .xls or .csv,
and the first column must be the six digit provider number, including leading zeroes, and
the second column must be the fiscal year end in the format MM/DD/YYYY). Once the
provider master list is imported, and the MAC number assigned to these providers, we
will match the provider number and MAC number when exporting HCRIS – i.e. if you do a
Batch HCRIS for 50 files, and some are J-1 and some are J-9, we search the provider
number list for a match, and assign the respective MAC number to the HCRIS export. You
can edit/modify/add to the provider list, as once it is imported from the .xls file, it is
basically a free form input sheet. You can add as many MAC Numbers and provider
number lists, as you want.  Only the “Administrator” at the MAC can do this. 

On the Tools menu, select Administrative Tasks. In the upper left corner is a new tab
for MAC/Provider Data. If you have a MAC name and number entered under
Preferences, it will transfer here. If not, simply enter the data, or change it to the desired
number. Then click the Import tab on the right side of the screen, specify the location and
name  of the file you want to import, and import the provider numbers and fiscal year ends.
Do this for each MAC Jurisdiction. We now have our reference table for HCRIS. We
match the S-2 provider information to this table and export the appropriate MAC number
for the HDT file. To delete a MAC tab, simply right click on the tab and select Delete.
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Filename Extensions14

Extension Description Do you need this
file?

.mcr Data file for Medicare cost reports (2552-
96, etc.)

Yes

.clt Data file for California Long-Term
Disclosure Report (LTCIR)

Yes

.mcrx Data file for 2552-10, 2540-10 and 265-
11 cost reports.

Yes

.mcrx.fs~ Temporary file. Yes, if the cost report
file is open.

.cdr Main data file for California Hospital
Disclosure Report (CHDR)

Yes

.tmp Temporary storage file created during
calculate

Recommended

.txt/.PDF Text or Adobe PDF files, created if you
select Print to File

No

.Damaged Created by Restore/Reorganize tool No, this is a damaged
file.

.bpl Program File for HFS software Yes

.dat Data file for error descriptions Yes

.lbl Temporary label file No

.rav Report formatting file for the HFS software Yes

.Updated Information file for updates No

           Acceptability Checklist

.acc Associated with Acceptability Checklist Yes

          Auditor Extensions

.mca, .mcax Adjusted cost report file; contains applied
audit adjustments.

Yes, if using Auditor

.tma Temporary storage file for MCA file;
created during calculate

Recommended

.Auditor Stores audit adjustments used in Auditor Yes, if using Auditor

.Auditor.BK Auditor backup of adjustments Yes

         Automated Account Interface Extensions
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Extension Description Do you need this
file?

.airx Stores all assignment rules Yes

.aaix Contains account, amount, and cross-
reference information

Yes, if using AAI

         339 Extensions

.xprq Main data file that contains 339
information

Yes, if you are using
339

         Management Reports

.255296mrx Management report groups and global
tolerance criteria

Yes

         PS&R Extensions

.mcp Contains all PS&R information Yes

.xrd PS&R file Yes

         Data Extractor

.csdx Contains specifications of data to be
extracted

Yes

.csv Comma separated file Yes

.dsc Batch Data Extractor Specification
Criteria file

Keep/delete - user
generated

.dss Batch Data Extractor Specification file Keep/delete - user
generated

         Professional Desk Review

.pdrx Data file Yes

.pdtx Template file Yes

         Wage Index

.wic Data file Yes

.wit Template file Yes
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